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Quickdex Basics
Quickdex is a freeform database you can use as a place to put names and phone numbers, jokes, code 
fragments, or a million other miscellaneous pieces of information.
 
Quickdex replaces the Cardfile program that comes with Windows. Unlike Cardfile, Quickdex allows you 
to search forward and backward, allows wild card searches, and allows (essentially) unlimited file and 
card sizes. The concept behind Quickdex is to present a simple, clean interface, with well implemented, 
useful features.

Quickdex uses two main edit boxes, the Find box and the Text box. You put information you want to save 
in the Text box. To find information, you put some portion of the text you want to find in the Find box and 
press <Enter>.

Within the Text box of a Quickdex card, you may use the standard cursor movement keys, as well as 
<Enter>, <Insert>, <Delete> and <Backspace> with the expected results. The <Tab> key switches your 
cursor between the text box and the find box.

An Edit menu appears if you press the Right mouse button within an edit box, or either mouse button 
anywhere else (anywhere that isn't a button or edit control). You can also enable "Drag and Drop" editing 
if you want the text area to work like "Word for Windows". The standard keyboard accelerators for editing 
also work (i.e., <Ctrl-X>, <Ctrl-Ins>, etc., depending on whether you are using Windows 3.0 or 3.1). 'Undo'
on the Edit menu undoes very little, so if it doesn't work, try <Alt-Z> to restore the card to its saved state.

Quickdex can display your cards in normal (or 'card') view or in a 'list' view. You can display your cards in 

list view either by clicking on the list button , pressing <Alt-L>, or choosing List View from the card 
menu. In 'list' view, the first line of every card that matches the Find box text is displayed (to a maximum 
of 50 characters). To see the entire contents of a card when you are in list view, double click on the card 
you want, or select it and press enter. Other functions, like dialing a number, deleting a card, or opening a 
new file also switch you back to card view.

Quickdex notes whether a file has been marked 'Read Only' when it loads it, and displays a message 
noting that. Quickdex does not allow you to change read only files, and disables the New, Delete and 
Save buttons, as well as disallowing any changes in the text area. Text can still be copied from the text 
area to the clipboard.

See also: Quickdex Keys



File Handling
When you first run Quickdex, it prompts you for the name of a card file. If you are creating a new file, 
simply type a file name (or use the default). Once you have specified the file name, it is remembered in 
the file QDW.INI and is automatically loaded when you start Quickdex again.

Opening and Creating Files
To change to a different file, select a file using the 'Open/Create data file...' option from the Quickdex 
system menu, or File menu.

Quickdex remembers the four most recently used data files, and they appear in the system menu and File
menu. You may switch between your currently open file and an older one either through the menu, or by 
pressing <Alt-2>, <Alt-3> or <Alt-4> (to get to the second, third or fourth file on the list). 

The most recently used file (the first file on the list) is opened whenever you start Quickdex. You can 
override this by specifying a filename on the Quickdex command line (use the File, Properties command 
in Program Manager). This option is useful if you always want a particular file to open when you start 
Quickdex, regardless of the last file used.

Saving Files
To save changes to your current file, click on the save button, choose Save from the File menu, or 
press<Alt-S>. Saving is disabled until you change the file. If you hold down the <Ctrl> key when you click 
on the save button, or choose Save As from the File menu, you will be presented with a "Save As..." 
dialog box, -- letting you select a new name, or save the file in different formats.

When you save the file, Quickdex remembers various preferences including the position of the Quickdex 
window, your current font, and your choices for the display of menu, buttons, and date-stamping.

See also: Using Macintosh Quickdex Files,    Using Cardfile files,    Importing Text files,    Save As...



The Save As... Dialog

The Save As.. dialog allows you to save your Quickdex file in different formats, or save only a subset of 
your file. Click on a portion of the graphic below to get more information about the options available.



Using Macintosh Quickdex Files
Opening Mac Files
To convert a Macintosh Quickdex file to Quickdex format, open the Mac file from the Open... dialog as if it 
was a Quickdex file (type in the name or select 'All files' in the Open... dialog). Quickdex for Windows 
recognizes Macintosh format Quickdex files (version 1.4), and asks if you want to convert them. If you 
choose to convert, the file will be overwritten with the Windows format when you save the file. 

Saving Mac Files
You may save your file in Quickdex for Macintosh format by holding down <Ctrl> when you click on the 
Save button, or choose 'Save As...' from the File menu. You will be requested to verify that you want to 
write in Macintosh format. 

Note that to use the file on the Macintosh, it will need to be 'stamped' with a creator of QDEX and a type 
of TEXT (case-sensitive). If this doesn't make any sense, you need to find a Mac expert to help you.



Using Cardfile Files
Opening Cardfile Files
Quickdex recognizes and automatically converts Cardfile format files. 

To load a Cardfile file into Quickdex, open the Cardfile file from the Open... dialog, then confirm that you 
wish to convert the file to Quickdex format. Note that the file on disk is not converted until you save the 
file. If you wish to maintain the original Cardfile file, choose 'Save As...' from the File menu to give the file 
a different name.

Quickdex uses the Index line from the original Cardfile card as the first line of the Quickdex card. Except 
for the index line, information in any card that contains graphics in the original Cardfile is lost. Lost data is 
indicated on the Quickdex card with <card data lost>.

Saving Cardfile Files
You may save your file in Cardfile format by choosing 'Save As...' from the File menu, and clicking on the 
'Cardfile' format option.

Quickdex uses the following rules to create a Cardfile card. 

If the first line of the Quickdex card is less than 40 characters, it becomes the index line of the Cardfile 
card, and the remainder becomes the data. If the first line is more than 40 characters, the first 40 
characters become the index, and the balance of the card becomes the data. In this circumstance, the 
index and data may 'break' in the middle of a word.

Cardfile can display a maximum of 400 characters in its data area. When saved in Cardfile format, a 
Quickdex file saves the entire contents of any Quickdex card in a single Cardfile card. This means that 
some data in your Quickdex card may not be viewable in Cardfile. If the unmodified Cardfile is read back 
into Quickdex however, all data is recovered.



Importing Text Files
Quickdex recognizes and converts Cardfile and Macintosh Quickdex files automatically, but has no 
automatic way of importing 'plain text' files. If you load a text file, Quickdex will assume the entire text 
goes on a single card.

A plain text file can be converted to Quickdex format very easily however. To convert text to Quickdex 
format you must have a consistent character or series of characters separating each record (or card) in 
the original text file. This separator can be a Carriage Return (CRLF), a symbol (e.g.!) or a string (e.g. 
xxx). To convert the text to Quickdex format, the separator must be changed to a Quickdex separator 
character, 0x7F or 127 decimal. In most Windows applications this separator would look like a 'box' 
character.

You can convert your separator character (or string) to the Quickdex separator character using a word 
processor or editor. For example in Windows Write, you would do the following.

1 Load your text file in Write (File, Open)
2 Choose Find, Replace from the menu
3 in the 'Find What:' edit box, enter YOUR record separator .e.g. !, xxx or whatever string you 

are using. For Carriage Return use ^p (circumflex followed by lower-case P). 
4 Tab to the 'Replace With:' edit box
5 in the 'Replace With:' edit box do the following:

- hold down the 'Alt' key.
- on the numeric keypad type 0127
- release the 'Alt' key

6 Click on the 'Replace All' button
7 Choose File, Save As...
8 Save the file as a TEXT ONLY file.

The file is now in Quickdex format.



Printing
The Print Options dialog box is available from the File menu and system menu. Click on a portion of the 
graphic below to get more information about printing options.

Printing Tips
As with a search, Quickdex thinks of your file as circular. If you print 'matching' or 'all' cards without 
sorting, printing begins with the next card and loops around the file to your current card.

Quickdex can print 'sets' of cards if they have a word or phrase in common. To print a set of cards, put the
word or phrase the cards have in common in the Find box, then choose 'Matching cards' from the Print 
dialog.

Because Quickdex is a freeform database, sorting has only limited usefulness. Nevertheless, the first line 
of the card can be used as a sort field and contain a code, date, or duplicated information from elsewhere 
in the card. (note that the sort is based on the entire contents of the card, not just the first line). By 
selecting 'Don't print first line' from the Print dialog, you can sort your cards without having the sort key 
appear on the printout.

Quickdex uses the default printer specified by the Control Panel. To use a different device, you must 
change the default printer in the Control Panel. 

Quickdex offers RTF format in the Save As... dialog. If you can not get the results you want printing from 
Quickdex, try saving your file in the RTF table format and using a Word Processor to print your results. 



Quickdex Keys
The following <Alt>-key combinations are supported:

<Alt-A> Same as <Alt-N>, adds a new card.
<Alt-B> Displays the last card viewed before the current card. <Alt-B> will only work if you 

have not changed the current card.
<Alt-D> Deletes the current card. You will be requested to verify the deletion.
<Alt-G> Disconnects (Hangs-up) the modem.
<Alt-J> Copies the selected text from the Text box to the Find box and searches for the next 

occurrence of the text.
<Alt-K> Inserts a datestamp in the current card at the cursor position.
<Alt-L> Switches to list view.
<Alt-M> Toggles menu bar on/off.
<Alt-N> Creates a new, empty card.
<Alt-P> Reads or dials the highlighted (selected) number in the current card. If you press 

<Shift-Alt-P>, Quickdex will find a phone number on the current card and read or dial 

it (same as clicking on  or 

.)
<Alt-Q> Same as <Alt-X>, exits (quits) the application.
<Alt-S> Saves any changes made to the file.
<Alt-T> Toggles between Quickdex always on top, and normal mode (requires Windows 3.1).

<Alt-U> Toggles button bar on/off.
<Alt-X> Exits the application. If you have made changes to the file and have not saved them, 

you will be prompted to do so.
<Alt-Z> Undoes all changes to a card -- up to the last time the cursor was moved out of the 

text edit box.
<Alt-1> Loads the first file listed on the system menu. Usually that is the file you are working 

with. It is a quick way of discarding all changes you have made to a file.
<Alt-2> Toggles (switches) between the last two files you have been using. Similarly, <Alt-3> 

through <Alt-9> cycle through the last three to nine files you have been using. 
<Alt->> Increases the font size in the text area by 1 point. 
<Alt-<> Decreases the font size in the text area by 1 point. 
<Alt-?> Displays the About Quickdex... dialog. 

Except for <Alt-P>, <Alt>-key combinations are not case sensitive.

See also: Basics, Quickdex General



Searching for Text
Cards with matching text can be found by typing a string in the Find box and pressing <Enter>. 

Repeatedly pressing <Enter> will find each subsequent occurrence of your string. You can press <Shift-
Enter> to find the previous occurrence. You may choose to have your search start in the next (or 
previous) card or continue in the same card by setting the Search in card option on or off. 

If you do not enter a search string, then you will simply jump to the next (or previous) card. You may also 

press the scroll buttons  

 to the right of the Find edit box to search forward or backward, or choose 'Next' or 'Previous' from the 
Card menu. 

Quickdex thinks of a file as circular, so a forward search will find your card whether it appears ahead of or 
behind your current card. If the search string is not found, the application will beep.

If you select an area of text in the Text box and press <Alt-J>, Quickdex will jump to the next card that 
contains the selected text.

See also: Search Considerations, Wild Card Searches



Search Considerations
Forward searches are much faster than backward searches. Generally there is no reason to search 
backward, as a forward search will cycle through the entire file.

Forward searches are faster if you use a longer search string. As a rule of thumb, a string twice as long 
can be found in half the time.

If you skip past a card when searching forward, it is faster to use <Alt-B> to go Back to the previously 
found card. <Alt-B> only goes back one card.



Wild Cards
You may use wild cards in your search by prefacing your search string with a tilde, '~'. Wild cards only 
work with a forward search and slow your search down considerably. Wild cards include '?' to match any 
character, '*' to match any number of characters (including none), and '[x-y]' to match any character in the
range x through y. For example:

        ~2[0-9][0-9]9    matches 2349 and 2569, but not 289a.
        ~a*b    matches ab, Albert, and axle-lube, but not ball.
        ~al*st*rt matches Alan Stuart, Allen Stewert and AL STEWART, but not A. Stewart.
        ~a??c    matches ACDC, "bad cat", and acac, but not abca.

As with other searches, wild card searches are not case-sensitive.



Dialing and Reading Phone Numbers
Quickdex will use your modem to dial a number or read a number aloud depending on what port you have
chosen in the Options dialog. 

Normally, to have a number read or dialed, simply click on the  button or select the number you want 
to use and then click on the 

 button. Quickdex can be told to dial a number in one of three ways:

1) Clicking on the  button tells Quickdex to look first in the currently selected text for a phone 
number and dial it. If it does not find a number in the selected text, Quickdex will look through 
the entire card, and dial the first phone number it finds. 

2) Pressing <Alt-P> tells Quickdex to dial exactly what is in the selected text. Use this method to dial
phone numbers that have fewer than 7 digits (e.g., office locals), to avoid dialing an area code, or to dial 
numbers with unusual characters mixed with the digits.

3) Pressing <Shift-Alt-P> tells Quickdex to look through the card until it finds the first phone 

number and then dial it. This is the same as pressing  when no text is selected in the card.

See Also: Modems, Quickdex Options, Voice Options



Modems
Quickdex may take several seconds after a connection is made to hang up the modem. To have Quickdex
disconnect earlier or to cancel dialing in progress, press <Alt-G>.

Quickdex assumes a Hayes compatible modem and prefixes telephone numbers with ATDT by default. 
Some modems may not work initially with Quickdex. If this is true with your modem, you can configure 
your modem to work with Quickdex by clicking on the [Modem...] button in the Quickdex Options dialog to 
get the dialog shown below. Click on any part of the diagram to get more information about the options 
shown.

The first four edit boxes in the Modem Configuration dialog allow you to specify your own command 
strings for dial prefix, dial suffix, post dialing, and hang up.

The two checkboxes on the dialog are for dealing with modems that don't seem to work with Quickdex. 
Allowing you to either hold the COM port open or to bypass Windows when writing to the COM port.

If you find you can not get your modem to work, contact Stellar Software for additional help.



Quickdex Options
Quickdex Options are available by selecting 'Preferences...' from the Options menu or by clicking first on 

the , and then on the Options button. Click on a portion of the graphic below to get information about 
each option.

Note that Options you select through the Options dialog are remembered the next time you start 
Quickdex. Options selected through <Alt> keys are not saved when Quickdex exits. 



Voice Options

If you have selected the PC Speaker in the 'Options' dialog, clicking on the  tells Quickdex to look in 
the current card for a phone number and read it out. 

Quickdex uses sound files that come with the application, but you may specify your own sounds.

To use your own sounds, you must record WAV files for each digit and place them somewhere in the path.
Wave files are named yyyyyyx.WAV where x is a digit from 0-9, and yyyyyy is a prefix of your choice. You 
tell Quickdex to use your wave files by specifying your prefix in the Options dialog.

For example, if you wished to have Quickdex speak in French, you would record ten wave files -- named 
FRENCH0.WAV through FRENCH9.WAV. Then specify the wave file prefix as 'FRENCH'. After making 
this change, Quickdex will use your sounds when speaking a phone number.



Miscellaneous Information
Information-only Messages
You can disable the 'splash' displayed when Quickdex starts by adding the line 'LG=0' to QDW.INI. The 
value for LG specifies how long (in seconds) the splash will appear. Clicking on the splash (or any other 
information-only message) while it is displayed makes it go away.

File Format
Within a Quickdex file, card records are strung end-to-end, delimited by ASCII 127 (0x7F) characters. To 
merge two files, use the DOS copy command (copy file1+file2 file3).

Command Line
Quickdex accepts a file name as a command line argument. A file specified on the command line 
overrides any filenames found in the QDW.INI file. This is useful if you are installing Quickdex on a 
managed network and wish to have a default file loaded for new users or if you want to set up several 
icons for Quickdex - each loading a different file (Quickdex allows multiple instances).

Recently Used Files
Quickdex remembers the last four files you have used and shows them in the File menu and System 
menus. You can set the number of files that Quickdex remembers from 1 to 9 by adding the line 'MAXF=x'
to QDW.INI, where x is the number of files.

The Little Dot on Top of the Text Box
Quickdex uses a dot on the top border of the Text box to indicate the relative position of the current card 
within the entire file. The dot is drawn in the opposite color from the border as shown below.

For the most part, knowing where the card is in the file is not really useful. However, if you have many 
many cards, and are searching for a term that appears many many times, it is sometimes useful to know 
when you have 'wrapped around' the file and are looking at the same cards again.

Limitations
File size is limited by available RAM, as the entire file is loaded into memory for use. Individual cards are 
limited to 30,000 characters.

Contacting the Author

If you find any bugs or other undesirable 'features' or wish to make a suggestion, please contact the 
author through one of the means shown. 

Sorry, but I can't afford to return long distance phone calls. E-mail, letters and suggestions are welcome 
and responded to.



INI File settings
The following keywords are used in the QDW.INI file. They are all in section marked [Quickdex]. 'Status' 
values are 1 or 0.

LG = time in seconds for splash to appear
F0 = first file on file list
F1 = second file on file list
F2 = third file on file list
F3 = fourth file on file list (etc.)
DP = dial prefix for modem
DS = dial suffix for modem
DM = pause status during dialing
LGP = long distance dialing prefix
LCP = local dialing prefix
VC = valid characters in phone number
QDSND = wave file prefix
DD = port to use (206-210)
HU = hangup string
AD = after dialing string
MAXF=number of files to show in recently used file list



Port to Use

Select whether you would like phone numbers read aloud or played on your modem.

Selecting Speaker will make the  button appear and phone numbers will be read aloud. Note that you 
must have Windows 3.1 and a sound driver installed for this to work.

Selecting COM1 through 4 makes the  button appear and Quickdex will use a Hayes-compatible 
modem on the COM port chosen to dial the phone number.



Wave File Prefix

If you are using the speaker to read phone numbers, Quickdex uses WAV files to hold the sounds for 
individual digits. If you wish to choose between alternate WAV file sets (i.e., other languages, 
male/female, dial tones) you may specify a different file prefix to use in this edit box. 

See Voice Options for more information. 



Local Number Prefix

If you need a special dialing sequence to precede local calls (e.g., 9 to get an outside line) you may enter 
that sequence in this edit box. 

Quickdex assumes numbers of seven to nine digits are local calls.



Long Distance Prefix

If you need a special dialing sequence to precede long distance calls (e.g., 1), you may enter that 
sequence in this edit box.

Quickdex assumes numbers of ten digits or more are long distance.



Valid Characters

This is the set of characters that Quickdex thinks make up a phone number. If you use different 
characters, add them to this list. A 'space' is always valid.



Always on Top

Selecting this option causes Quickdex to remain the 'topmost' window at all times (Windows 3.1 only). 
You may toggle this option on and off by pressing <Alt-T> while Quickdex is active, or by selecting 
'Topmost' from the Options menu.



Search In Card

Use this option if you want to find a string in different places in the same card.

By default, whenever you start a search, Quickdex starts the search from the next card (or previous card 
if you are searching backward). Selecting this option tells Quickdex to search from your current cursor 
position rather than from the next (or previous) card. 



Select Font...

Press this button to access a font selection dialog. The font you select will be saved for use every time 
you start Quickdex. The Font dialog may be accessed directly by choosing the 'Font...' from the Options 
menu. 

The default font is MS Sans Serif, Regular, 8 pt. 



Configure Modem...

Press this button to access the modem configuration dialog box. How to use this dialog is described in the
Modems section of this help file. 



Show Menu

Use this option if you wish to have a standard Windows style menu for Quickdex. You can turn the menu 
on and off by pressing <Alt-M>. Every item on the menu is also available either through a keystroke, a 
button, or the system menu.



Show Buttons

Use this option if you wish to display the button bar on the bottom of the Quickdex window. You can turn 
the button bar on and off by pressing <Alt-U>. 



Date Stamp New Cards

Select this option if you want new cards to be automatically stamped with the date and/or time. Use the 
edit box to set the format for your datestamp. Pressing <Alt-K> inserts the datestamp into your current 
card.

The datestamp format edit box uses 'C' style codes to set the appearance of the datestamp. The following
table shows which codes to use to format your datestamp.

%a Abbreviated weekday name
%A Full weekday name
%b Abbreviated month name
%B Full month name
%c Date and time representation appropriate for the locale
%d Day of the month as a decimal number (01-31)
%H Hour in 24-hour format (00-23)
%I Hour in 12-hour format (01-12)
%j Day of the year as a decimal number (001-366)
%m Month as a decimal number (01-12)
%M Minute as a decimal number (00-59)
%p Current locale's AM/PM indicator for a 12-hour clock
%S Second as a decimal number (00-61)
%U Week of the year as a decimal number; Sunday is taken as the first day of the week 

(00-53)
%w Weekday as a decimal number (0-6; Sunday is 0)
%W Week of the year as a decimal number; Monday is taken as the first day of the week 

(00-53)
%x Date representation for current locale
%X Time representation for current locale
%y Year without the century as a decimal number (00-99)
%Y Year with the century as a decimal number
%z Time zone name or abbreviation; no characters if time zone is unknown
%% Percent sign

Any other characters used in the format string appear as typed. Note that the default format for date 
stamping is YY/MM/DD HH:MM. This insures that cards using the date stamp as a sort key, sort correctly.



Dial Prefix

If you need to use an alternative or additional commands to make your modem dial, enter the complete 
command string in this edit box. For example a dial prefix of ATM0&D0DP would turn the speaker off, tell 
the modem to ignore DTR and use 'pulse' dialing instead of 'tone'.



Dial Suffix

In the unlikely event that your modem requires a string after the number dialed, you may specify a dial 
suffix in this edit box. 



After Dialing String

The 'After Dialing' string can be used to send an additional command to the modem after the dial string is 
sent. For example, if you were to send a command to reduce 'Carrier Detect' time to 3 seconds 
(ATs7=3DT) as your dial prefix, you may wish to restore the setting after you have dialed the number with 
the After Dialing string, say ATs7=30.



Hang Up String

The 'Hangup' string can be used to change the command sent by the <Alt-G> keystroke (default ATH).



Display Message After Dialing

If your modem never dials, or seems to hang up before it finishes dialing, you may need to tell Quickdex 
to hold the COM line open. Selecting this option causes Quickdex to display a message box when you 
dial a number, and hold the line open until you click on the OK button. 



Direct COM Port Access

Some modems appear to ignore Quickdex but work well with other applications. If this is true with your 
modem, select this option to have Quickdex communicate with the COM port directly. 



OK

Click on this button when you are satisfied with the selections you have made and wish to continue. 



Cancel

Click on this button if you wish to cancel any selections you have made and abort the procedure.



Help

Click on this button to get help for the dialog box you are currently using.



Save Normal

Select this radio button to save your file in the normal Quickdex format.



Save Macintosh

Select this radio button to save your file in Quickdex for Macintosh version 1.4 format. Remember the file 
must be marked with a creator of QDEX and a type of TEXT to be read by Quickdex on the Mac.



Save Cardfile

Click on this button to save your file in Cardfile format. Remember that Cardfile has size limitations that 
Quickdex does not. Data saved in Cardfile format may be lost or unreadable in Cardfile.



Save RTF

Click on this button to save your file in RTF format. This format saves each card entry in a separate RTF 
table cell. Note that 'tab' characters in your text are converted to an underscore, backslash '\' characters 
in your text can cause unpredictable results and should be avoided.



Save As Filename

Enter the new name for the file you are saving in this edit box.



Save Matching Only

Check this button if you want to save only Quickdex cards that have text that matches the text in the Find 
edit box. Currently this option is only available for saving in Cardfile and RTF formats.



Setup...

Click on this button to change the default setup for your printer. Setup will display a dialog dependent on 
the type of printer you have installed.



Print Current Card

Selecting this radio button tells Quickdex to print only the currently displayed card.



Print Matching Cards

Selecting this radio button tells Quickdex to print all cards that contain text matching the text in the Find 
edit box.

If you do not choose to sort, printed cards are found from the next card to the end of the file, and then 
from the beginning of the file to the current card.



Print All Cards

Selecting this radio button tells Quickdex to print all cards in the file. 

If you do not choose to sort, printed cards are found from the next card to the end of the file, and then 
from the beginning of the file to the current card.



Separate Cards with Blank Line

Selecting this radio button puts a blank line between each card printed.



Separate Cards with a New Page

Selecting this radio button forces a page break between each card printed.



Separate Cards with a Custom String

Selecting this radio button puts whatever text you specify between each card printed. The text you wish to
use is limited to a single line and must be entered in the edit box beside the radio button. If you put 
nothing in the edit box, nothing will separate cards (not even a blank line). 



Sort Cards

Select this option if you would like the cards sorted when printed. Cards are sorted based on the entire 
content of the card.



Don't Print First Line

Select this option if you want to suppress printing of the first line of the card. Note that the first line ends 
when you press enter, not when the line wraps at the edge of the window. 

By selecting this option you can use the first line of the card to hold a sort field or grouping information 
about the card without having to print that information.



Suppress Formatting

Use this option to suppress the header, footer and indentation Quickdex uses on printed output. This 
option is particularly useful if you are exporting a Quickdex database to a file.



Exit

Clicking on this button will quit (exit) the application. If you have not saved your file, you will be prompted 
to do so.



The System Menu

The System Menu (also called the Control Menu) appears in the upper left hand corner of the application, 

and look like this: .

Quickdex uses the System menu to hold the Open, Print and Exit (Close) menu options.



Find Area

Enter the text you wish to find in this box and press <Enter>. For more information, see Finding Text. 

Pressing the right mouse button in this box brings up an Edit menu.



 The Mouth/The Phone 

Clicking on this button will find a phone number on the displayed card and read it out or dial it using your 
modem. For more information see Quickdex Options or Voice Options.



New

Clicking on this button adds a new, blank card to your file. The cursor is automatically positioned inside 
the text box. 



Save

Clicking on this button saves your file. This button is disabled until you make a change. See File Handling 
for other file options.



Help

Clicking on this button brings up the Quickdex 'About' dialog with a short help file. From the About dialog 
you can bring up more detailed help by selecting 'More Help' or change Quickdex options by clicking on 
Options.



Previous Card

Clicking on this button displays the previous card that matches the search criteria specified in the Find 
text box. If there are no matches, the application will beep.



Menu Bar

The menu bar in Quickdex works like most other Windows applications. However you can toggle the 
display of the menu bar on and off by pressing <Alt-M>.



List Button

Clicking on this button switches from card view to list view. Only those cards that have text containing the 
Find box text will be listed. To switch back to card view, double click on a card in the list.



Next Card

Clicking on this button displays the next card that matches the search criteria specified in the Find text 
box. If there are no matches, the application will beep.



Delete Card

Clicking on this button will delete the card displayed. You will be requested to confirm the delete before 
the card is actually deleted. Deletions can be "Undone" only by exiting the application without saving.



Drag & Drop

If drag and drop editing is enabled, you may "drag" an area of selected text to a new position. When the 

cursor is over a "selected" area it looks like . When you are dragging text to a new position, the cursor 
looks like 

.

If you hold down <Ctrl> when you drag text, it will be copied instead of moved to the new position.



Text Area

Type anything you want in this area. Click on other buttons to find data or create new cards.

If you press the right mouse button in this area, an Edit menu will be displayed. If you don't like using "Cut
& Paste", you can use "Drag and Drop" editing instead.
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